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1 Overview

1.1 Introduction

The Ethernet Phone VP3302 is a next generation IP Phone that provides a
cost-saving solution for small business/home users on their telecommunication needs.
The VP3302 follows the open standard SIP protocol to make sure that users can easily
install this IP phone with most existing VoIP (Voice over IP) services. By using
state-of-the-art DSP (Digital Signal Processing) technology, the VP3302 delivers

outstanding voice quality that is comparable to PSTN voice quality.

With the built-in LCD display, the user can easily configure the VP3302 for first
time installation in a few minutes. And besides the advanced VoIP functions and easy
installation, the VP3302 also provides rich telephone features such as last number
redial, speed dial, phone book, call forward/transfer, call history, volume adjustment
and speakerphone. The VP3302 is the best VoIP solution in the new generation of

communication.
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1.2 Key Features

Follows RFC-3261 SIP standard:

o Supports password authentication using MD5 digest and RFC-2833 for
DTMEF relay.

Dynamic IP support (DHCP and PPPoE):
o Gets IP from DHCP server using DHCP protocol or through ADSL

modem using PPPoE protocol, and automatically reconnects when

PPPoE loses connection.
Passing through NAT devices:

o Can make outgoing and incoming calls under any NAT device (even
under two layer NAT devices) when working with the specific

gatekeeper/proxy devices.
Remote software upgrade capability (via ftp):
o FTP protocol provides reliable remote upgrades through the Internet.

Advanced Digital Signal Processing (DSP) technology to ensure superior
audio quality:

o Chip solution with built in DSP processor ensures perfect voice

quality.
Supports G.723.1, G.729A/B, G.711 (A-law/U-law) voice codecs:
o Follows ITU-T standard to support best compatibility.

Supports supplementary services, including immediate (unconditional) call
forwarding, busy call forwarding, no answer call forwarding and call
hold/transfer.

Provides call history:

o Records incoming call history, outgoing call history, missed (not

accepted) call history, and let users make direct calls from call history.
Phone Book: 50 sets
Speed dial: 10 sets

Supports Silence Suppression, VAD (Voice Activity Detection), and CNG

(Comfort Noise Generation):

o Silence suppression can save about half of the network bandwidth

needed during normal VoIP conversation.
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e Ping function supported:

o Pings other device in the Internet from the VP3302 to make sure the

Internet connection is ok.
o System status display on the LCD panel:

o User can easily know if the VP3302 is working normally and monitor
the system’s status (network status, registering status) from the LCD

panel display.

o A “PKT Trace” function is supported to display the packets received

on the LCD panel to let administrator find network problems online.
o Calls with or without proxy server (direct IP dialing):

o Follows standard SIP protocol and is compatible with most existing

SIP proxy servers
e Provides easy configuration methods:
o Very easy settings by using the keypad on the phone set.
o Settings by web browser.

« Supports RFC-3261, TCP/UDP/IP, RTP/RTCP, HTTP, ICMP, ARP, DNS,
DHCP, NTP/SNTP, FTP, PPP, PPPoE protocols.

o Interoperable with most existing SIP VoIP devices (IP-phone, gateway, proxy,
soft-switch, IP-PBX), including Microsoft NetMeeting, Cisco gateways
/gatekeepers:

o Please refer to section 6.2/6.3 Interoperability List for the complete

listing.

e The WAN Port automatically works for parallel Ethernet cables and crossed
Ethernet cables.
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1.3 Hardware Specifications

HARDWARE SPECIFICATIONS

Spec\Model

PC Port

WAN Port

LCD display

Phone Case

Universal Switching Power Adaptor

Speaker
Dimension
Weight
Operating Temperature
Humidity

EMI Compliance

VP3302

1 x RJ45 10/100 Base-T Ethernet, line auto-sensing/switching.

1 x RJ45 10/100 Base-T Ethernet, line auto-sensing/switching.

(Optional) Power Over Ethernet 802.3af function.
2x16 characters

36-button keypad

Input: 100-240V AC

Output: +7V DC, 800mA

8 Ohm/0.2 Watt speaker for speakerphone operation
19cm(W) x 23cm(D) x 9cm(H)

8709

32 - 104°F (0 — 40°C)

10% - 95% (non-condensing)

UL/EN/FCC Class B

Table 2. Hardware Specification of VP3302
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2 Basic Installation
2.1 Appearance Introduction

2.1.1 Key parts of the VP3302
The key parts of the VP3302 series IP Phone, shown in figure 1,

include the following:

1.2 x 16 LCD Display 5. Handset
2. Keypad 6. Ethernet Cable
3. Indicator of usage 7. Power Adaptor

4. User Manual

Figure 1. Key parts of the VP3302 series IP Phone
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2.1.2 Rear and Back side Panel of the VP3302

The rear and back side panel illustrations are shown in figure 2 and 3.

Main parts include:

1. RJ-45 Ethernet Port
2. RJ-45 Ethernet Port
3. Power Adaptor Jack
4. Jack of line to handset

3 7 1

Figure 2. Rear Panel of the IP Phone

Figure 3. Back Side Panel of the IP Phone
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2.1.3 Keypad Definition

- Y.
- o
\s 10.
3 ; |
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4 = 11
— 12.
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6. = 14
- =
i y > 13.
8.
16
Figure 3. Keypad illustration
1. LIGHT
The red light flashes when there is an incoming call.
2. LCD DISPLAY
Menu and status are displayed for users.
3. “€@UP”KEY
When the IP phone is entered into the menu selection, this key is used to
scroll up menu items.
And when the IP phone is editing menu item’s contents, this key is used as
“left delete” to delete a digit per each key press.
When the IP phone is in dial mode, the “< UP” key is used as the “delete”
key.
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4.

5.

6.

“DOWN =>” KEY
When the IP phone is entered into the menu selection, this key is used to

scroll down menu items.

And when the IP phone is editing menu item’s contents, this key is used as

“right shift” to shift the cursor right a digit per each key press.

-INVOL. +
When the IP phone is in an idle state or the handset or speaker is being used,

this key is used to increase/decrease the volume of the voice sound.

The volume of the speaker, handset and ring are separately adjusted
according to the mode of current usage. When in idle, “+” key increases the
volume of the ring tone, “-” key decreases the volume of the ring tone; in
hand-free mode, “+” key increases the volume of the speaker, “-” key
decreases the volume of the speaker; when in handset mode, “+” key
increases the volume of the handset, “-”” key decreases the volume of the
handset.

+ OUT VOL. -
Users are able to increase/decrease the volume which is sent out to the

remote party.

SPEAKER
This key is pressed to switch between the usage of the handset and the

speaker.

HOLD
Holds the conversation.

This key can also be pressed to do a consultant-transfer of an active call to
another IP phone. When the IP phone is active (incoming call is answered or
outgoing call is accepted), by pressing this key, a dial tone will be heard,
then the user can key in the IP phone number of another party and have a
conversation with him. Then, by pressing the “TRANSFER” key, the call

will be transferred to this new party.
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10.

11.

12.

13.

NET
When users are not successfully registered to their service provider, this
button light will flash. Users can press this button to try to register again to

their service provider.

MESSAGE

This is for future use with functions upgrade.

MENU/OK
When the IP phone is in an idle state, this key is used as “Menu” to bring

out the menu selection on the LCD display.

When inside the menu selection/setting on the LCD display, this key is used
as the “OK” key to enter into a lower layer of menu selection or to accept

the edited item’s contents.

When the IP phone is in dial mode, the “OK/Menu” key is used as the “Dial
Out” key.

CANCEL
When the IP phone is entered into the menu selection, this key is used to

escape to an upper layer of the menu selection.

And when the IP phone is editing some menu item’s contents, this key is
used to cancel the current edit and escape to an upper layer of the menu

selection.

TXT <— NUM
When users need to enter characters, press this button and the alphabets

shown on the keypads will be displayed.

TRANSFER

This key is pressed to transfer an active call to another IP phone. When the
IP phone is active (incoming call is answered or outgoing call is accepted),
by pressing this key, a dial tone will be heard, then the user can key in
another IP phone’s number to transfer the call to another party. If the call

transfer is successful, a busy tone will be heard to notify the user to hang up
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14.

15.

16.

the phone. If the call fails, the user can press the “Transfer” key again to

retrieve the original call connection.

When a call is incoming and the IP phone is ringing, by pressing the
“Transfer” key and then another IP phone’s number, a user can transfer the

call immediately to another party without answering the call.

RE/DIAL
When the IP phone is off the hook and some number has been dialed, this
key is pressed to call out. The “#” key does this same function to send out a

called number.

When the IP phone is taken off the hook and this key is pressed immediately

afterward, the last dialed number will be called out right away.

SPEED DIAL M1 - M10

Users are able to store 10 specific phone numbers in the slots of M1 - M10.
Users are able to make a speed dial call to the specific party by pressing the
speed dial key from M1 — M10.

PhoneBook
Users are able to store up to 50 phone numbers by pressing the
“PhoneBook™ button. For each item of the 50 phone book numbers, the user

can store both the number and the name for display.
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2.2 LCD Menu List

The following is the roadmap of the menu on your IP phone.

View

» Network Value

» Ping

> Restart

>
>
>
>

IP Address
Network Mask
Default Route
DNS Server

» Image Version
» (Yes/No) PKT Trace

Configure (Password: 135)

» Network

» SIP

>
>

Y

YV V V V

(Yes/No) Dynamic IP
(Yes/No) PPPoE
» Ifyes:
»  PPPoE Username
»  PPPoE Password
Static IP
IP Address
Network Mask
Default Route
»  DNS Server

Time Zone

YV V V

Login ID

Number

Password

(Yes/No) Proxy On

» If Yes:
»  Proxy Address
»  Proxy Port

(Yes/No) Outbound Proxy

» If Yes:

13
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»  Outbound Proxy IP
»  Outbound Proxy Port
» SIP Domain Name
» Frame Size

» Forward Mode
» (Yes/No) Immediate
» If Yes:
» Immediate Number
» (Yes/No) Busy
» If Yes:
»  Busy Number
» (Yes/No) No Answer
» If Yes:
» No Answer Number

> No Answer Time

Advanced (Password: 1230)
» System
» DSP Version
» Upgrade/DnLoad
» FTP Server IP
» Image File Name
» Upgrade Image
» Upgrade Loader
» Config Profile
» Debug Mode
» Dump Address
» Dump Size
» Dump!
» Network
» MAC Address
» NTP Server
» (Yes/No) APS Enable
» APS Server
Restart Count
RTP Process
» (Yes/No) Bypass Server

Y VvV
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» (Yes/No) Jitter Buffer
» (Yes/No) Auto Upgrade
» Phone Advanced
» Codec
» G711u
» G7lla
» G729
» G723
» DTMF
» DTMF Relay
» Payload Type
> \oice
» (Yes/No) VAD
» BG Noise Level
» Volume
» Ring Volume
» Handset Volume
» Hand free Volume
» Codec Tx Gain
Scrn Con (0-9)
Ring Type (1-10)
» Ul Mode
» Console
» Lcd
» Both
» SIP Advanced
> (Yes/No) ImpPxyOn
» Jmp Number

Y VvV

» Jmp Password
» Jmp Proxy Address
» Jmp Proxy Port
» Protocol
» (Yes/No) STUN Server
Media Port
Reg From
Reg To
Reg Expire

YV V V V V

Reg Action
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» Local Port
» User Setting
» Platform
» Billing Server

» User Name
» Password
» Confirm Password
» Admin Username
» Admin Password
» Statistics
» User Statistics
» Call Missed
» Call Received
» Call Dialed
» Phone Statistics
» Call Missed
» Call Received
» Call Dialed
» Additament
» International
» My Country Code
» Area Prefix Code
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2.3 Installation Environment

- Internet

Step 1
v Connect to internet

Step 2
Connect to PC

Step 3
Power adaptor

Figure 4. Installation Environment

Step 1:
Please take out your IP phone and its handset. Then connect your handset to
the IP phone by plugging it into the left jack of the handset. If you use
RJ-45 broadband connection, please connect your network cable from your
broadband modem to the WAN port of your IP phone, such as NAT, HUB,
ADSL, or CABLE.

Step 2:
If you would like to have a PC online at the same time, please connect this

port to your PC.

Step 3:
Plug in your power adaptor to your IP phone and power source. The LCD of
your IP phone will display “Starting....... ” and then the “SIP” menu will

appear within approximately 4 seconds.
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3 Configuration from The Keypad

The VP3302 series IP Phone installation design is very friendly. Almost all the
configurations can be done through the keypads and LCD screen display on the
phone set in a few minutes. In order to make a VoIP call, please do the

configurations through the keypads as described in the following few sections.

Note:

(1). When inputting an English character in any menu item, please press that
key button quickly to switch between the different characters until the
correct one is found.

(2). When the input mode is in digit mode ( inputs are ‘0’~’9”and “*’,’#’), if an
English character is needed, please press the “TXT <— NUM?” key first
to toggle to ““character” input mode.

3.1 Network Configuration

When using the VP3302 IP Phone, first set the network configuration to let
the IP Phone connect to the internet. , The proper method to configure the IP
Phone to connect to Internet depends on the network environment and phone

model.

3.1.1 Dynamic IP Method (DHCP)

Most of the network environments at the office, a hotel room or home are
under a NAT (IP sharing device/router device). Under this environment, the
easiest way to connect to the internet is using the DHCP method. The IP Phone
when configured using this method will get the IP parameters dynamically, and

connect to the internet automatically.

Configure » Password : 135 P Network P (Yes/No) Dynamic [P

Please press the “OK” key to set Yes on “(Yes / No) Dynamic IP” when
using DHCP method.
Most cable modem connections also use the DHCP method.

3.1.2 PPPoE Method
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Most of the broadband network environments provided now by ISPs are
ADSL connections Under this environment, the IP Phone can directly connect to
the ADSL modem by entering the PPPoE account information (user name and
password) provided by the ADSL service provider. Please follow the directions

below.

Configure P Password : 135 P Network P (Yes/No) PPPoE

Press the “OK” key to set Yes on “(Yes/No) PPPoE” when using the
PPPoE method. And then key in the account information from the ISP vendor.

PPPoE Username — Please input the user name of the account given by the
ADSL ISP.

PPPoE Password — Please input the password of the account given by ADSL
ISP.

3.1.3 Static IP Method

For other network environments, users will need to set the static IP provided

by the ISP or from a MIS person in the office.

Configure » Password : 135 P Network P Static IP

Under the “Static IP” submenu, please key in the IP address, network mask

and default router settings provided by your ISP or private IP address.

Once all the network settings are completed, please restart your IP phone.
You are now able to check whether your internet connection is working
properly. Go to View = Ping, then key in a public IP address (e.g. 168.95.1.1)

to ping. If the response is ok, then the network settings are completed.
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3.2 Registration to Proxy Server

After the network environment is set and connected to the Internet, you can
register the IP Phone to the SIP Proxy server by using the account from your VoIP
vendor/operator. The following methods to register to a gatekeeper or proxy server
depends on your IP Phone model.

3.2.1 Registration to a proxy server

When the VoIP vendor/operator is running a SIP system, configure the
following parameters to register the VP3302 to the proxy server.

Configure » Password : 135 » SIP

A. Number — Please input the phone number (username) to register to the proxy

SCrver.

B. Password — Please input the password to register to the proxy server.

This password is carried in the SIP Proxy-Authorization field using the
MDS5 digest method for authentication purposes. Not every proxy server
needs this field. If not needed, keep it empty.

The VP3302 follows the standard RFC-2617 to do authentication.

C. Login ID — please input the username for registration authorization.

When the IP Phone is registering to the proxy server, the Authorization
field will have the username = “xxxxx”, if the “Login ID” entry is empty, the
username will use the “Number” input value, but when the “Login ID” field
has some value, the username will use this “Login ID” value for
authorization.

D. (Yes/No) Proxy On — please select Yes and register to the proxy server.
After this item is enabled, two more menu items will appear. One is the
proxy server address; it sets the IP address or domain name address of the
proxy server. Another is the proxy server port, to set the port of the proxy

server; its value is usually 5060 unless specified by the service vendor.
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If the IP Phone does not register to a proxy server, it still can call

another IP phone by calling the IP address directly.

E. (Yes/No) Outbound Proxy — please set this item to Yes if the registration

needs to pass through the Outbound Proxy server.

Note: Most proxy servers now have the built-in ability to let IP Phone pass
through NAT/router devices. This pass-through function does not need the IP
Phone to change anything. This method is also more reliable, easier and
successful than the other NAT pass-through methods like STUN. The Outbound
Proxy method is similar to the Proxy server built-in NAT pass-through solution,
except that the packets need to pass through the Outbound proxy server. And of
course, this pass-through method does not need the IP Phone to change anything.
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3.3 Registration/Startup Message

When the network and registration configurations are set, please restart the IP
Phone, the LCD display on the IP phone will show one of the following messages

depending on whether the registration is ok or not.

(a). When the IP Phone registered to a SIP proxy server successfully, the LCD

screen will display the following message:

SIP (number)
Date Time

This means that the VP3302 is working and ready for outgoing/incoming

calls. The number inside braces () is the IP phone’s number.

SIP (Proxy On)

Date Time

This means that the VP3302 is working and ready for outgoing/incoming
calls. But if the LCD displays the “Proxy Off”, then the IP Phone did not
register. In this case, to malke calls, dial the IP address of other IP Phone
directly.

(b). When the IP Phone is configured to use a proxy server, but has not yet
registered successfully or has failed, the LCD screen will display the

following message:

Registering (number)

Date Time

When the “Registering” message is displayed, the IP phone can not
make any calls, but the menu selection and the on-hook/oft-hook function

can work.

(c). When the IP Phone has failed in registering to a SIP proxy server, the LCD

screen will display the following message:
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().

(.

RegFail (failed message)
Date Time

The failed message could be one of the following:

(1). Duplicate: means that the registering number is duplicated with
another, or the IP Phone’s previous registration information is still kept
in the gatekeeper/proxy server and was not unregistered last time (this
could happened if the IP Phone is powered off instead of restarted from
the menu item). If the previous registration information is not cleared,
you may need to wait about 4 minutes before the IP Phone can register
successfully again.

(2). Security: means that the account (username/password) is not correct.

Please check your account again.

When the RegFail message is displayed, the IP phone can not make any

calls, but the menu selection and the on-hook/off-hook function can work.

When the IP Phone fails in registering to a SIP proxy server, the LCD screen

will display the following message:

DHCPFail (number)

Date Time

This means that the IP phone is configured to use DHCP to get an IP
address, but the DHCP procedure failed (can not find a DHCP server or the
DHCEP server rejected the IP assignment). The IP phone can not make any
calls, the on-hook/off-hook functions can not work, and no sound is heard
on the handset and the speaker. Only the menu selection can work.

The IP phone will continuously try to get an IP address from the DHCP
server. So, if the DHCP server is responding, the DHCPFail() display will
change to SIP() to notify the user that the IP phone is working.

When the IP Phone is set to use the PPPoE method for network connection,

but has some problem in finding the PPPoE server (ADSL modem), the
LCD screen will display the following message:
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PPPoE FindFail(number)
Date Time

This means that the IP phone is configured to use PPPoE to get IP
address, but the PPPoE procedure has failed (can not find a PPPoE server or
the network connection has some problem). The IP phone can not make any
calls, but the menu selection and the on-hook/off-hook function can work.

When the IP Phone is set to use the PPPoE method for network connection,

but there is some problem in the PPPoE account, the LCD screen will

(8)

display the following message:

PPPoE AuthFail (number)
Date Time

This means that the IP phone has been configured to use PPPoE to get
an IP address, but the PPPoE server has refused the connection because the
username/password are not correct. The IP phone can not make any calls,

but the menu selection and the on-hook/off-hook function can work.

(). When the IP Phone has enabled “Immediate Forward”, the LCD screen will

display the following message:

FWD(number)
Date Time

This means that the VP3302 is working and ready for

outgoing/incoming calls. But for any incoming call, it will be forwarded to
the “Immediate Forward Number”. The IP Phone with the “Immediate

Forward” function enabled will not ring.
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3.4 Configurations under “View” item

Under the “View” menu item, there are many submenu items. These items are
mainly for quick information about the current status of the IP Phone and also to
provide some simple functions to check the network status of the IP Phone, as
described below:

3.4.1 View current network settings

By selecting “View” > “Network”, you can see your current IP Address,
network mask, default router and DNS server address. Depending on the network
method configured under the Configure>Network submenu, the IP Phone could
get its [P address through modem, DHCP, PPPoE or static method. Viewing these
values allows you to know the current, real IP address settings.

3.4.2 Ping another device

The “Ping” function is one of the most often used tools for PCs to check if the
network connection is ok or to check if another device is there. By selecting
“View” = “Ping” and keying in the IP address or domain name of another device,
the IP Phone can check if the connection to that device is ok. This could also be
used to check if the connection to the Internet is ok by pinging another device that
is already in the public Internet area. For example, you can ping 168.95.1.1 or

www.hinet.net to check the public connection status.

3.4.3 “Warm restart” the IP Phone

By selecting “View” —-> ‘“Restart”, the IP Phone will “warm restart”
immediately. This “warm restart” is different from the power down/up (cold
restart) action in that the “warm restart” will do the “un-registration” process to
the gatekeeper or proxy server if the IP Phone is registered. The “warm restart”

will also disconnect the modem connection if a modem is connected.

3.4.4 Displays current image version

By selecting “View” > “Image Version”, the users can view the current

software version in the IP Phone. The software version is identified by the date
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of release of the software image.

3.4.5 Packet Trace for signal monitoring

If the IP Phone has some problem registering to the gatekeeper or proxy
server, or there is a problem making or receiving VoIP calls, then, select “View”
- set “PKT Trace” to (Yes). The LCD screen will then display all the signaling
messages received, and this allows users to monitor the signals to possibly

identify the problem.

26 www.edge-core.com



VP3302 IP Phone User Manual

3.5 “Forward” Configurations

The VP3302 series IP Phone supports three different kinds of call forward
functions, please select “Configure” = “Forward mode” for these three kinds of

selections:

3.5.1 Immediate Forward

Under “Forward mode” submenu, users are able to setup for immediate
forward by selecting Yes on the “(Yes/No) Immediate” and input the number he/she
would like the call to be forwarded to. For example, when A calls B, and B’s phone
has Yes set for “(Yes/No) Immediate” with number 555-5555, then, under any
circumstance, a phone call from A will be forwarded to number 555-5555.

When the “immediate forward” is enabled, “busy forward” and “no answer

forward” can not be enabled. Only one can be enabled at a time.

3.5.2 Busy Forward

Under the “Forward mode” submenu, users are able to setup for busy forward
by selecting Yes for “(Yes/No) Busy” and input the number he/she would like calls
to be forwarded to when this phone is busy (active). For example: B has set Yes on
“(Yes/No) Busy” with number 555-5555. When A calls B, and B’s phone is busy,
the call from A will be forwarded to number 555-5555.

3.5.3 No Answer Forward

Under the “Forward mode” submenu, users are able to setup for no-answer
forward by selecting Yes on “(Yes/No) No Answer” and input the number he/she
would like the call to be forwarded to when the phone is not answered for the
specified amount of seconds. For example: B’s Phone has Yes set for “(Yes/No) No
Answer” with number 555-5555 and no-answer time equals 10. When A calls B,
and B’s phone is not answered, then, the call from A will be forwarded to number

555-5555 after ringing for 10 seconds with no answer.
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3.6 Software Upgrade

The VP3302 series IP Phone provides a very simple software upgrade
method. Follow the hot key definitions in section 6.1 (table 3) to upgrade the
different models. The upgrade is done from the FTP server configured inside the
IP Phone, or can be changed from the Web configuration described in section
4.5.

During the software upgrade process, do not power down the IP Phone until

the upgrade is done.
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4  Configurations on The Web

The VP3302 series IP Phone also provides web interface for configuration.
Key in the IP Address of the IP Phone using any web browser (IE5 Explorer or

Netscape). You will see the following login window:

100t
= [Username: ‘

skesfoskok

= Password: ‘

enter

Please key in the username “root” and password “1234”, then press “enter”.
You will enter the home page of the IP Phone as shown below.
From this first page, you will get the basic information of the IP phone. You

also can set the configurations by selecting the specific pages:

IP Phone Overview

tht_ina Image Version: 4.0,Jun 29 2004,17:59:17
Network Value:

o [P Address: 192.163.0.81

o Network Mask: 255.255.255.0
o Default Router: 192.168.0.1

o DNS Server: 168.95.192.1

T
Network PlatForm:
sip o Platform: 804
Phone
System
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4.1 Network Configurations on the Web

By clicking on the “Network” icon on the left banner, the following page will

be displayed to allow you to set all the network related configurations.

IP Phone Network

setting = Basic:
v 1. DynamiclF:

2. PFPCE: O
2. PPPOE Password:

3. Static IF:
1. TP Address: 192168050
2. MNetwork Magk: 2952552550
3. Default Router; 19216801
4. DN§ Server: 168951921

Phone
System
= Others:

1. MAC Address: 0020f0H009%

2. NTP Server: 193131153

3. Time Zone: * View

4.1.1 Basic

Please see section 3.1 for the explanation of each field.

4.1.2 Others

41.2.1 MAC Address —

View the MAC Address of the IP Phone. Not changeable here.

4.1.2.2 NTP Server -

Set the NTP (Network Time Protocol) server’s IP Address for the IP

Phone to get current date/time and display it on the LCD screen.

41.2.3 Time Zone —

Specify the time zone of your area. You can click the nearby “View”

icon to see the time zone of your area. For example, set the value to 8
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for the Taiwan area.
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4.2 SIP Configurations on the Web

By clicking on the “SIP” icon on the left banner, the following page will

display to allow you to set all the SIP related configurations.

IPPhone s

settina » Sip Paramelers:
= 1. Account; 430241

_ PIN: |weeesse

. Proxy Cn:
. Proxy Addr: 19224669103

. DutbndFroxy: [

Overview

2
3
4
5. Proxy Port: |S060
6
i
8

Network . OutbndFroxyIE:
o o . OutbndProzxy Prt:
E -
Phone -
System

= Forward Mode:
1. Immediate: [

. Immed Number:
. Bugy: O

. Mo Answer: [

2

3

4. Busy Number:
5

6. Nofns Number:
7

. No&ns Time:

= Advanced:
1. Reg From:
Eeg To:
Reg Expire; /500
Min Media Port: 1000
Max Media Port: | 10004
Codec: OG711n O G711a OG729 @ 0723

FELTERT L [

4.2.1 SIP Parameters

Please see section 3.2 for the explanation of each field.

4.2.2 Forward Mode

Please see section 3.5 for the explanation of each field.

4.2.3 Advanced

4.2.3.1 Reg From:

Modify the “From:” field in the SIP/SDP messages. This should be left

empty unless for a specific system.
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4.2.3.2 RegTo

Modity the “To:” field in the SIP/SDP messages. This should be left

empty unless for a specific system.

4.2.3.3 Reg Expire:

Modify the value “Expires:” field in the SIP/SDP messages. This will

control the re-registration period.

4.2.3.4 Min Media Port:

This is the minimum value for the range of the transmitted RTP

packet’s port.

4.2.35 Max Media Port:

Thhis is the maximum value for the range of the transmitted RTP

packet’s port.

4.2.3.6 Codec:

This is the type of Codec for the transmitted RTP packets. In the SIP
call process, the type of Codec negotiated is determined by the called

party.
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4.3 Phone Configurations on the Web

By clicking on the “Phone” icon on the left banner, the following page will

display to allow you to set all the phone related configurations.

IP Phone Phone

setting = Prefiz:
1. International Code:
2. My Country Code:
3. Area Prefiz Code:

=y
Overview
Network = Voice:
L. RN L. Ring Volume(09): 2
Phone 2. Handset Volume(D-9): °
sysmm 3. Hondtee voRENT
4. CodecTxzGain(0-9): 0
—— 5. Ring Type: @ Type 1 O Type 2.0 Type 3 O Type 4 O Type 5 O Type 6 O Type 7 O Type 8 O Type 9 O Type 10
6. RTPLowEW:
7. JitterBuffering:
=)
= Others:
1. VAD:
2. BG Noise Level(0-9): 0

4.3.1 Prefix

For some specific VoIP systems, when the IP Phone calls the PSTN or
a mobile number, the called number must include the country code. For
example, the country code of Taiwan is 886. So, if the user wants to call
02-25621234 in Taipei city, then the called number needs to be
886-2-25621234. But this is not consistent with normal dialing behavior.
In order to use normal dialing behavior, set the “My Country Code” value
to 886, and set the “Area Prefix Code” value to 0.

As for the “International Code”, when you want to dial an international
call, the International Code will be removed. For example, suppose a user
wants to make a call to China, the dialed number will is
002-86-2112341234, the IP Phone will remove the “International Code”
002, and send the real number of 86-2112341234.

This prefix code implementation is only needed for some specific VoIP
systems. Normally, this is not needed, just let all the prefix values be

empty.
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4.3.2 Voice
4.3.2.1 Ring/handset/handfree Volume —
Adjusts the volume of the receiving voice.
4.3.2.2 CodecTxGain -
Adjusts the output voice volume.
4.3.2.3 Ring Type -
Adjust the ring type (ring pattern) of an incoming call.
4.3.2.4 RTPLowBW -
This ability improves voice quality of the transmited direction if the
internet bandwith is not sufficient by decreasing the voice packet
bandwidth.
4.3.2.5 Jitter Buffering —
This adjusts the jitter buffering ability of receiving voice packets from
the normal 150ms to 400ms. In some specific internet connections, the
traffic arrives with large jitter, i.e. bad voice quality. You can improve
the voice quality by enabling the “Jitter Buffering” function.
4.3.3 Others
4.3.3.1 VAD-
Voice Activity Detection, the IP Phone will detect if the user is talking

or not, and avoid sending voice packets when the user is silent to decrease

the bandwidth requirement.
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4.3.3.2 BG Noise Level -

This value controls the sensitivity of the VAD detection.
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4.4 System Configurations on the Web

By clicking on the “System” icon on the left banner, the following page will
display to allow you to set all the system related configurations.
In this page, you can do the software upgrade, change the username/password

of the web login account and reboot (restart).

IB phqne_ System

N » Upgrade:
Setting
” 1. FTP Server [p: 152168023
2. ImageFile Name; #2200 kin.zz
Upgrade MNow!

Overview s Change web Username & Password:

Network
. oot
e 1. Username:
2. Password: *®®®
Phone )
System
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5 Call Functions
5.1 Making Calls

To make a call, pick up the handset, dial the desired party’s number, and end
with the “#” key to complete the dialing. An alternative way to make a call is to
press the light blue button (“SPEAKER” key) at the lower-left corner. Dial the
desired party’s number, and end with the “#” key to complete the dialing.

Note: This “handfree” operation can only hear the remote party’s voice, there is
no handfree microphone to send out voice. (microphone is optional)

5.2 Receiving Calls

When a call is incoming and the IP Phone is ringing, to receive this call, just
pick up the handset.

5.3 Checking call history (incoming/outgoing/missed calls)

The call history can be displayed on the LCD screen by pressing the “<
UP” key or “DOWN ->” key when the IP Phone is in an idle state.

There are three kinds of call history:

“Incoming” is the record of numbers and time of last 10 incoming calls that
were answered.

“Outgoing” is the record of numbers and time of last 10 successful outgoing
calls.

“Missed” is the record of numbers and time of last 10 incoming calls that
were not answered.

When viewing the number of any call history, you can press “MENU/OK”
key to do one of the following three actions:

1.Dial — to call the number by directly pressing the “MENU/OK” key again.

2.Delete — to delete the item from the call history.

3.Add To PhoneBook — adds the name and number of the item to the phone
book. The added item is automatically sorted alphabetically in the phone
book.
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5.4 Auto Redial

Users are able to call out using the last dialed number (redial) by pressing
“RE/DIAL” key after taking the handset oft-hook or in handfree mode.

5.5 Call Forward

You can set the call forward functions through the keypad or web
configurations. Please refer to section 3.5 for the detailed settings and function

descriptions.

5.6 Call Transfer

The IP phone supports two types of call transfer functions. They are blind
transfer and consultant transfer.

5.6.1 Blind Transfer

With blind transfer, users transfer the caller/callee to a third party without
informing the third party who is transferring the call. For example, A calls B and
A want B to transfer the call to C. B will transfer the call to C by pressing
“TRANSFER” button first. When B hears a dial tone, B dials C’s number. B then
hangs up.

The flowchart of a blind transfer:

A calls and talks to B
A asks B to transfer the call to C.
B presses the “TRANSFER” key.
B hears a dial tone.
B dials the number of C.
C is ringing.
C answers.

B is disconnected automatically.

5.6.2 Consultant Transfer

With consultant transfer, users transfer the caller/callee to third party by
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informing the third party who is transferring the call. For example, A calls B. A
wants B to transfer the call to C. B will transfer the call to C by doing the
following. B presses the “HOLD” button, and after hearing a dial tone, B dials
C’s number. B talks to C, B hangs up and then A can talk to C.

The flowchart of the consultant transfer is:

A calls and talks to B.
A asks B to transfer the call to C.
B presses the “HOLD” key.
B hears a dial tone.
B dials the number of C.
C is ringing.
C answers.
B talks to C.
B hangs up or presses the “TRANSFER” key.
A can talk to C.

5.7 Call Hold

Users are able to press HOLD to do consultant transfer, but if the number of
the third party is not dialed in 8 seconds, the IP Phone will go in to “Hold” state.

By pressing HOLD again, both ends are able to continue the conversation.
5.8 Phone Book and Speed Dial

By simply pressing the Phone Book button at the right bottom corner, users
are able to restore, in total 50 phone numbers with this function. When users
press the Phone Book button, the two options shown in LCD display are Phone
Book and Speed Dial.

After selecting the Phone Book option, users will see Add, Edit, Delete and
Delete All. To add a person’s name and number, users may select the Add
function. To edit or delete phone book information, users may simply select the
edit or delete function in this category. Users may delete all information in the
entire phone book by selecting Delete All.

To set up the speed dial function, users should select Speed Dial and M1-
M10 will be displayed in the menu. When selecting each slot, two options are
shown; Current Info and Change Setting. Current Info displays the phone

number for a slot. By selecting Change Setting, users are able to change the
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person in the phone book list for that individual slot.
After the speed dial items M1-M10 are set, users can make speed dial calls

by directly pressing the M1-M10 key when the phone is off-hook.
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6 Attachment

6.1 Hot Key Definitions

Hot keys are a sequence of keys pressed when the IP Phone is in an idle

state.

The following table defines the hot key sequence and their corresponding

functions.
Hot Key Function
#*101* Upgrade MAC
#*102%* Test LCD
#*103* Test LCD and Keypad
#*104* Loop back test (call out)
#*105* Loop back test (call in)
#*109* MAC Check and modify
#*110%* Set to default
#*112* Upgrade software of VP3302
#*800* Clear Gatekeeper IP
#*801* Platform #801
#*802* Platform #802
#*803* Platform #803
#*804* Platform #804
#*805* Platform #805

Table 4. Hot key definitions
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6.2 SIP Interoperability List

The followings are the lists of some of the devices that have been tested to be
interoperable with VP3302 series IP Phone.

Client/Terminal
-SCS-Client V1.00

-SIPS 2.0.43.11
-SJ-Phone 1.10.187¢c
-X-Lite — FWD V2.0
-Softphone — Simems V0.90Bata27
-Estara V3.0.0.15

-Cisco ATA-186

-Cisco 7905

-BCM SIP Phone
-GrandStream SIP Phone

Proxy Server
-Wparty SIP V0.5.0
-Wparty SIP V0.5.5.2
-FI#5@]F ¢ ZTE SOFT SWITCH
-Asterisk 0.5.0

-Linux — Vovida V1.5
-Linux — Vovida V1.5
-SER 0.8.10
-WalkerSun softswitch
Gentrice proxy server
Inphonex platform
DeltaThree platform
NEC SV7000 IP PBX

Trunking Gateway

-Cisco 5300
-Quintum D2400
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